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Greetings from the 
AASHTOWare Bridge Task 

Force. We continue to live during 
very dynamic times. Many of 
us have been back to the office 
since last summer and some of 
us are still working from home. 
Some have even adopted a hybrid 
approach of working in the 
office and working from home. 

Throughout this all, our contractors and users continue to 
deliver high quality work—whether it is updated software, 
bridge designs or bridge load ratings.

AASHTOWare released Bridge Management™ 6.4 in 
January 2021 and Bridge Management 6.5 in June 2021. 
Those releases introduced many new updates and bug fixes 
to the software. For additional details on these releases, 
see the Letter from the AASHTOWare Bridge Task Force 
Vice-Chair.

AASHTOWare also released Bridge Design and Rating™ 
7.0 in January 2021. This release marked the conclusion of 
the multi-year project, with a short hiatus for the change in 
contractor. Many states have adopted this new version and 
are taking advantage of the new features and processing 
speed increases. Some states are taking a ‘wait and see’ 
approach and will adopt the modernized system following 
the release of Version 7.1.

So, what is in version 7.0? The new version significantly 
upgraded the core technology to a modern software 
architecture that takes advantage of new and existing 
hardware as well as the latest software technology.  
With the modernized AASHTO analytical engine, there 
are significant improvements on the analysis runtime 
performance for all structure types and the modern 
software architecture allows for future performance 
enhancements. Modifications to the User Interface also 
provide an enhanced user experience. In addition to 
those improvements, this release provides the following 
capabilities and features:

	Ū AASHTO LRFD Bridge Design Specifications updates (9th 
Edition);

	Ū AASHTO Manual for Bridge Evaluation updates (3rd 
Edition with 2020 Interim Revisions);

	Ū Load Rating Tool enhancements: LFR analysis of floor 
systems, multi-cell box beams, and culverts; and

	Ū Ability to specify vehicle and traffic lane placement settings 
for live load analysis of floor beams and floor trusses.

Scheduled for delivery in August 2021, Bridge Design and 
Rating 7.1 is currently in Beta testing. Some of the many 
new features delivered in 7.1 include:

	Ū Analysis Results Comparison Tool

	Ū BrM Web Services Integration

	Ū 3D Analysis for Superstructures with hinges

	Ū Schedule based RC I-beam with Post Tensioning (Caltrans 
and Mississippi)

	Ū Multiple smaller enhancements for Multi-cell Box Culverts 
(Caltrans)

	Ū Enhanced Load Rating Tool Permit Analysis Settings

	Ū Bug Fixes and maintenance issues

Bridge Design and Rating 7.2 is currently in the design 
phase and development will start soon. Some of the new 
features that will be included are:

	Ū PS Design Tool—Phase 2

	Ū Steel Girder Design Tool

	Ū IFC Data Exchange

	Ū Addition of MCB and Multi-Girder LRFR—Load Rating 
Tool

	Ū Addition of Slab Systems LFR & LRFR—Load Rating Tool

	Ū Bug Fixes and maintenance issues

As a reminder, AASHTOWare will continue to support 
Bridge Design and Rating 6.8.4 until June 30, 2022. Only 
critical bug fixes will be incorporated into 6.8.4 during 
this time. Start making plans to migrate from the legacy 
version to the current software. Please contact ProMiles 
for assistance in any migration questions.

Mark Bucci led an effort to clean up, clarify, and document 
the current process for handling BrDR bugs, issues, and 
maintenance items. The newly refined process will be 
posted on the aashtowarebridge.org website once the 
documentation has been completed. As a component of 
the refined process, the AASHTOWare Bridge Task force 
will establish a BrDR Backlog TAG for users to participate 
in the process of handling the many issues that arise each 
year. Mark will reach out to the user community to solicit 
seek volunteers to serve as Technical Advisory Group or 
TAG members.

Mike Johnson is leading the BrDR Culvert TAG effort to 
implement metal culverts into the product. Following 
Chapter 12 of the Bridge Design Manual and methodologies 
used by several states in spreadsheets, the Culvert TAG 
has had several meetings to move this effort forward. The 

Letter from the ChairLetter from the Chair
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TAG is making great progress and has only a few items 
that still need to be addressed before design can begin.

Vinacs Vinayagamoorthy is leading the BrDR Reports 
TAG effort to revise and enhance BrDR reporting and 
data output. This initiative will support a more consistent 
approach to BrDR reporting and better meet the needs 
of our users. The Reports TAG has had several meetings 
and have come up with some great ideas. The Task Force 
will work with ProMiles to take their recommendations 
forward for incorporation into future releases of the 
product.

I don’t want to close this out without thanking one last 
time the following states who contributed both funding 
and DOT staff to support the successful completion of the 
BrDR Modernization Project. Special thanks to Alabama, 
California, Idaho, Illinois, Iowa, Kansas, Michigan, 
Minnesota, Mississippi, Montana, New Mexico, New 
York, Ohio, South Dakota, and Wisconsin. The project 
would have never been successful without the funding and 
the volunteer time the states provided to review mockups, 
review design documents, and beta test the software.

Todd Thompson, P.E.    
AASHTOWare Bridge Task Force Chair

Farewell to Judy TarwaterFarewell to Judy Tarwater

We want to take this opportunity to thank someone who has played a huge role in 
AASHTOWare Bridge’s growth in the last decade. Judy Tarwater will be retiring at 
the end of 2021 after a fruitful decade of serving as the AASHTOWare Bridge Project 
Manager. AASHTOWare Bridge has grown tremendously under her guidance and the 
Task Force’s oversight. While we’re all sad to see her go, we’re excited that she will 
have more time to dedicate to her lovely family and her sewing projects. 

Thank you, Judy. You will be missed!   

Judy has been so outstanding in organizing and keeping us informed. She is proactive, 
exceptionally welcoming, and so responsive. We also loved having Jay travel with her and 
coordinate and join us in evening activities, so we will want to thank Jay, as well. Judy and Jay 
are family, and it has made traveling and volunteering by the Task Force members so much 
more enjoyable since Judy takes special ‘care’ of all of us. 

–Tom Saad P.E., FHWA

Judy, I had the privilege of being the Chair of the AASHTOWare Bridge Task Force when you 
joined us in 2012. Through your high degree of enthusiasm and professionalism, there is no 
question BrM, BrR, and BrD have seen an incredible rate of growth and improvement in the 
last nine years. Thank you so much for devoting your time and incredible energy to assisting 
the Task Force and its contractors in developing such incredibly powerful software that 
benefits all the state DOTs and the traveling public they serve. Congratulations on your second 
“retirement,” and best of wishes on your future endeavors! 

–Tim Armbrecht P.E., S.E., Illinois Department of Transportation

Judy has been a wonderful project manager for the AASHTOWare Bridge Task Force. I’ve 
had the pleasure to work with her as the Chair of the Task Force. She tackles any task, no 
matter how small, big, important, menial, with the same amount of enthusiasm, detail, and 
professionalism. She anticipates and prepares for our (Task Force) needs before we even know 
we have needs. Her level of managing even the smallest of details continues to amaze me 
almost every day. Her attention to detail for every meeting ensures we can get as much work 
done during our meetings. She will be greatly missed, and I am glad she can spend more time 
with family and on her hobbies. 

–Todd S. Thompson, P.E., South Dakota Department of Transportation
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Understanding the BrDR Ribbon Interface Understanding the BrDR Ribbon Interface 
In the modernized BrDR user interface, the ribbon provides, at the top of the window, a logical organization of the 
commands the end user will use to create and work on bridges. Bridge Explorer, Bridge Workspace, Library, and 
Configuration each have their own ribbons. Each tab on the ribbon represents a single focal point for the operation of the 
commands on the tab, containing groups of commands that act on the single focal point of the tab. The ribbon interface 
makes access to the commands quicker and apparent; and helps to discover all the features and functionalities in one 
location. The modernized BrDR user interface provides a balance of the three basics aspects of a good user interface 
design: discovery, learning, and efficiency.

Bridge Explorer RibbonBridge Explorer Ribbon

The Bridge Explorer application button opens a menu of Bridge Explorer specific application-wide commands to access 
features such as user preferences and system data export/import.

Figure 1. The Bridge tab is composed of commands to operate on and manage bridges.

 

Figure 2. The Folder tab is composed of commands to operate on and manage folders.
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Figure 3. The Rate tab is composed of commands to access the load rating features in the Bridge Explorer.

Figure 4. The Tools tab is composed of commands to access the tools to operate on bridges.

 

Figure 5. The View tab is composed of commands to configure and control the information displayed in the 
Bridge Explorer. The Library command opens the Library module and the Configuration command opens 
the Configuration module of the program.
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Bridge Workspace RibbonBridge Workspace Ribbon

The Bridge Workspace application button, which can be accessed whenever a bridge is opened from the Bridge Explorer, 
opens a menu of Bridge Workspace specific application-wide commands to access features such as printing and help 
configuration.

Figure 6. The Workspace tab is composed of commands to operate on the bridge and manage the 
components of the bridge.

 

Figure 7. The Tools tab is composed of commands to access the tools to operate on the bridge.

 

Figure 8. The View tab is composed of commands to configure and control the information displayed in the 
Bridge Workspace.

 

Figure 9. The Design/Rate tab is composed of commands to access the design review and load rating 
features in the Bridge Workspace.
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Analysis Results Comparison (ARC) Tool— Analysis Results Comparison (ARC) Tool— 
New in Release 7.1New in Release 7.1
Historically, agencies have had different approaches to testing and upgrading to new versions of AASHTOWare Bridge 
Design-Rating (BrDR). Some agencies install new software versions immediately after the release with little to no 
testing, while other agencies perform extensive in-house testing or refrain from adopting the new version until the 
version has been out for a while and used by other agencies in a production environment. When implementing a new 
version, the rating results of a bridge or a group of bridges can change due to a variety of factors. These changes—which 
can lead to either beneficial or unfavorable results—are due to issue fixes or enhancements included in the new version, 
code changes, the inclusion of additional information to refine the analysis, or issues introduced in the new version.  
Regardless of the reason, agencies should be aware of the details of how a new version will affect the way they manage 
their bridge inventory.

To assist the states in assessing the impact that a new version of BrDR will have on the rating of the bridges in their 
inventory, the Analysis Results Comparison (ARC) tool compares the results between any version of AASHTOWare 
Bridge Design-Rating beginning with version 7.0 (i.e., all modernized versions of BrDR). For example, the ARC tool can 
be used to evaluate the rating results from BrDR version 7.1—which has an anticipated release date of August 2021—with 
the rating results from BrDR 7.0. Using this tool, agencies can compare the rating factors for a representative sample or 
all of the bridges in their inventory. The tool has three levels of comparison, with each increasing level providing more in-
depth analysis. The three levels include: Level 1—Overall Controlling Bridge rating; Level 2—Member Alternative rating; 
and Level 3—Point of Interest analysis. The three levels are described in more detail later in this article. 

When launched, the ARC tool opens the main Dataset Explorer window. This window allows the user to create, manage, 
and compare datasets. It also allows the user to run a scan for the versions of BrDR supported by the ARC tool. 

Figure 1. Analysis Results Comparison Tool Main Screen

Creates a dataset

Opens Dataset 
Comparison Window

Scans Computer for 
Versions of BrDR


¥
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The Create Dataset window is used to set the version to be used, define the analysis setting, and provide the location 
where the dataset will be stored. The window also has a checkbox to allow Level 3 analysis. The Level 3 analysis will 
provide much more detail for comparing each version; however, it produces much larger data files. To limit dataset file 
size, creating Level 3 datasets for a select group of bridges needing additional analysis is preferred. All bridges could be 
analyzed for both Level 1 and Level 2 analysis. Note that if/when an error is encountered when analyzing a bridge, the 
ARC tool closes the bridge with the error and continues to analyze the remaining structures. The bridge with the error 
will still be included in the list of bridges in the Level Comparison windows; however, the results for that structure will 
be blank.

 

Figure 2. Create Dataset Window

Through the ARC tool main Dataset Explorer window, two datasets can be selected for comparison. Clicking on the 
Compare button opens the Dataset Comparison Setting window. This window is used to specify a percent difference at 
which the ARC tool will flag the results. The tolerance for Rating Factor or Design Ratio (RF or DR) is used for flagging 
Level 1 and Level 2 analysis results. Capacity, Dead Load, and Live Load tolerances are used for Level 3 analysis. 

 

Figure 3. Dataset Comparison Settings Window

Live Load  
Truck Template

Level 3 Analysis 
Toggle
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The Level 1 Comparison window displays a comparison of the controlling load-rating factor for each dataset at the overall 
bridge level. The “Location same” and “Limit state same” column values will be shown in red if either of those respective 
values are different between the two datasets. Percentages changes are displayed in red if the value is greater than the 
specified tolerance. 

 

Figure 4. Level 1 Comparison Wndow

The Level 2 Comparison window displays a comparison of the controlling load-rating factor for each dataset at the 
member level. Similar to Level 1, the “Location same” and “Limit state same” column values will be shown in red if either 
of those respective values are different between the two datasets. Percentages change are displayed in red if the value is 
greater than the specified tolerance.

 

Figure 5. Level 2 Comparison Window 

Level 3 analysis is an in-depth comparison of the results. This comparison shows differences in dead load, live load, 
and capacity at all points of interest set under the control options.  This window can be used to pinpoint where the 
differences are in a model to assist in understanding why the rating factor or design ratio is different.  The Level 3 analysis 
produces large files; therefore, it is recommended to perform the Level 3 analysis only on select bridges that require 
further analysis.
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Figure 6. Level 3 Comparison Window

The ARC tool assists in testing new BrDR releases to provide comparison information that will provide agencies with the 
confidence they need to upgrade to the most current release of the software. The results can be retained and new versions 
can be compared to multiple past versions. For all comparison levels, the results can be exported to a CSV file that can 
then be saved in Microsoft Excel format to assist in managing the comparisons.

The ARC tool included in the BrDR version 7.1 release is the first generation of the tool. As agencies take advantage of this 
new tool, the Task Force welcomes input on features and/or recommended enhancements that could be included in the 
tool to support easier version comparison testing going forward.

Load Rating Tool for LRFR Coming in Release 7.2Load Rating Tool for LRFR Coming in Release 7.2
Bridge Rating version 6.8.1 introduced a new feature for quickly computing load ratings using the LFR method. The Load 
Rating Tool processes live load independent data required for computing a load rating which is saved in advance of the 
request for a load rating.  The availability of the precomputed data greatly reduces the computation time when a load 
rating is requested.

The Load Rating Tool for LFR has been a great success with quite a few states using this feature extensively in their 
permit routing systems. Building upon this success, this feature will be enhanced to support LRFR in version 7.2 slated 
for January 2022 release. Service unit contributions from Idaho TD, Illinois DOT, Indiana DOT, Kansas DOT, Louisiana 
DOTD, Ohio DOT, South Carolina DOT, Virginia DOT, and the support of the BrDR Task Force made this enhancement 
possible. 

Multi-girder superstructure (girder system/line), multi-cell box (reinforced concrete and post-tensioned), and slab 
system superstructure will be supported in this enhancement. The superstructure types currently supported by the Load 
Rating Tool and the versions they are first available are:
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Table 1. Superstructure and Rating Types by Version

Superstructure Type LFR LRFR
Multi-girder (RC, PS, Steel) 6.8.1 7.2

Multi-Cell Box 7.0 7.2

Culvert	 7.0

Floor System 7.0

Slab System 7.1 7.2

The Precomputed Data window will be upgraded to support running precomputed data analysis based on either LFR, 
LRFR, or Member Alternative analysis method type. The controls options override will be upgraded based on the 
selection of the analysis method type. Load Rating Tool analysis can be performed either for LFR, LRFR, or Member 
Alternative analysis method type. LRFR analysis through the Load Rating Tool will support running permit load rating 
analysis with adjacent vehicle. Permit load rating will also support running with a permit lane load along with the 
provision of gapping lane load at the permit vehicle location. Figure 1 illustrates the supported permit load rating features 
for the Load Rating Tool.

 

Figure 1. LRFR Permit Load Rating Configuration

BrDR Reports Tool—Initial Version Coming  BrDR Reports Tool—Initial Version Coming  
in Release 7.3in Release 7.3
Currently, AASHTOWare Bridge Design-Rating has the capability to design and load rate many bridge types and 
produce various individual reports for each type. Over time, as new capabilities and features have been incorporated 
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into the product, the software has become increasingly complex. Existing BrDR reports have been developed over the 
life of the product to meet the specific needs identified when new features were introduced. This approach has resulted 
in BrDR reports existing in various formats and scattered throughout the software, making it difficult to generate a 
comprehensive bridge report.  

Feedback from the user community has identified the need for a BrDR comprehensive bridge report as a high priority for 
the product to address the reporting limitations that currently require workarounds. In the absence of comprehensive 
bridge reporting within BrDR, some agencies have developed their own tools to process and combine BrDR-
generated reports into more comprehensive reports. Agency users require a simple tool that allows them to generate a 
comprehensive report within the BrDR software.  

In response to this feedback, ProMiles, the Bridge Task Force, and the BrDR Reports TAG are actively researching, 
planning, and developing bridge schema definitions and reports mockups to support the development of a new BrDR 
Reports Tool. The basic premise of the BrDR Reports Tool is to provide a platform that will easily support user-
generated comprehensive reports for available structure types, which will include input data, graphics, analysis results, 
specification check data, design review summary, and load rating summary reports. The BrDR Reports Tool will provide 
the user with BrDR report templates that can be readily used for report generation, as well as facilities that will allow 
the user to easily modify reports templates or create new reports. The first release of the BrDR Report Tool—planned for 
August 2022—will deliver a limited feature set (BrDR version 7.3).

Advanced Concrete Member Alternatives Available  Advanced Concrete Member Alternatives Available  
in Release 7.1in Release 7.1
New for the 7.1 release scheduled for August 2021 is the introduction of a new Advanced Concrete Member Alternative 
that can be either reinforced concrete or post-tensioned concrete. The post-tensioned concrete member alternatives 
allow partial length tendons, which allows regions of the beam to be analyzed as post-tensioned and other regions to be 
analyzed as reinforced concrete. The new Advanced Concrete Member Alternatives are available in girder system and 
girder line superstructure definitions. This new feature includes the ability to define post-tensioned I-beams and the 
ability to use the features of a girder system superstructure definition to model a multi-cell box structure as individual 
concrete beams.

Features of the new Advanced 
Concrete Member Alternatives 
include:

	Ū Wide variety of cross sections 
can be modeled including non-
symmetric and precast shapes

	Ū Regions of post-tensioning and 
regions of reinforced concrete 
within the same member

	Ū Overlapping post-tensioning 
tendons

	Ū Selection of stage of post-
tensioning application

	Ū Post-tensioned I-beams

Figure 1. Variety of Cross Sections



Page 13

 

Figure 2. Overlapping Tendons

 

Figure 3. Multi-Cell Box Modeled as Individual Advanced Concrete Girders
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BrDR Service Request ManagementBrDR Service Request Management
While AASHTOWare BrDR has long provided support services to its users, a recent re-evaluation and redesign of the 
process has been undertaken to provide better transparency throughout the review process for all users. Led by Task 
Force member Mark Bucci, the focus of the redesign includes an increased awareness of the categorization of service 
requests and the process for managing these requests based on the overall short term/long term benefits and the impact 
the request will have.

For the purposes of monitoring user requests, the following definitions have been established and have been in place for 
some time:

Table 1. Service Request Categories and Definitions

Term Definition
Bug An issue which prevents the software from working the way it was originally 

designed to work.
Urgent Bug A bug which prevents users from performing critical business functions.
Critical Bug A bug which produces incorrect final results without warning the user.
High Priority Bug A bug which produces incorrect results or prevents portions of the program from 

functioning, however, the user is alerted to the error (e.g., the program crashes and 
an error window is displayed or a warning is issued).

Low Priority Bug A bug which causes minor inconvenience to business process but has a known 
workaround.

Maintenance Missing or improperly handled functionality or feature that was not identified or 
scoped during development, but should be addressed.

Enhancement New functionality or improved usability that would expand the software feature set.
High Impact Resolution would benefit many states/clients, significantly improve software 

performance, or provide features that are in high demand.
Low Impact Resolution would benefit few states/clients, address isolated issues, or provide 

nominal improvements to existing features.

To facilitate and oversee the BrDR Service Request Management process, a Backlog TAG will be established to monitor 
the process. The responsibilities of the TAG will include:

	Ū Escalated Issue Review—This is a review of issues that have been escalated based on the engineering approach (interpretation 
of the code or different engineering approach) and issue type assignment (disagreement on the issue type assignment).

	Ū Bug Evaluation—Evaluate whether a bug is Urgent, Critical, High Priority, or Low Priority.

	Ū Maintenance and Enhancement—Evaluate and categorize issues to determine if they are High Impact or Low impact.

To guide the TAG involvement and to establish the benefit/impact and the short versus long-term nature of the requests, 
an Issue Evaluation Process has been developed to help categorize requests.
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Quadrant 3

•	 State Specific Enhancement
•	 Isolated Issues

Quadrant 4

•	 Nice-to-Have Features
•	 Nominal Improvement to 

Existing Features

Figure 1. Issue Evaluation Benefit/Impact

	Ū Quadrant 1—Issues will be fixed as soon as possible under the software maintenance contract.

	Ū Quadrant 2—Bugs will be fixed in upcoming release other items will be evaluated to identify potential implementation issues, 
identify related issues, establish a rough estimate, and prioritized based on User Group voting or through Task Force directed 
work.

	Ū Quadrants 3 and 4—Option will be provided for state funded service unit work or volunteer to champion effort to increase 
interest with other states. Otherwise, user will be notified that issue will not be incorporated and will be closed.

The figure below illustrates the anticipated workflow of the Service Request Management Process:

Figure 2. Service Request Management Process

Through this process and oversight, the BrDR Task Force will work to provide timely action on service requests that best 
serve the BrDR user group community as a whole, while providing a mechanism for agencies to improve the software for 
their individual needs.
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Letter from the Vice ChairLetter from the Vice Chair

The AASHTOWare Bridge 
Task Force would like to 
thank the user community 

for the AMAZING contributions 
over the last 12 months ranging 
from service unit donations, to 
participation on our Technical 
Advisory Groups, to pre-
solicitation funding commitments 
to incorporate the proposed 

changes to the National Bridge Inspection Standards and 
the new Specifications for the National Bridge Inventory. 
Your involvement is what ensures the AASHTOWare 
Bridge Management software remains up to date to meet 
the ever-changing challenges of bridge inspection and 
management across the country. Many enhancements were 
made to AASHTOWare Bridge Management in 2021 and 
more are coming! This newsletter provides information on 
the new 
functionalities available and the upcoming improvements 
planned for the AASHTOWare Bridge Management 
software. 

In January of 2021 AASHTOWareBridge Management 
Version 6.4 was released with the following key features:

	Ū Multimedia Enhancements

	Ū Addition of the remaining Federal Highway Administration 
(FHWA) validation checks

	Ū Addition of a “Date Entered” and “Entered By” fields on the 
Tunnel Inspection page

	Ū Enhanced Mapping to view surrounding bridges

	Ū Improved Optimizer log

	Ū Added a Weighted option to the Percent Condition State 
field for the Element Condition State action type on the 
Network Policies task

	Ū Various bug fixes and usability enhancements identified by 
the user community

In June of 2021, version 6.5 was released which significantly 
improved the Life Cycle Cost Analysis (LCCA) module in 
BrM. This release was a true ‘team effort’ including major 
contributions from the Optimizer and Testing TAGs to 
ensure this release is as impactful as possible for our users. 
A summary of the key features of this release are below 
but more information pertaining to LCCA can be found on 
page 18. 

AASHTOWare Bridge Management Version 6.5 includes 
the following key features:

	Ū LCCA Module to generate optimal Life Cycle Plans through 
recursive analysis.

	Ū LCCA Policies can be used to prevent a bridge from falling 
below a certain threshold

	Ū Visually compare up to three plans via Performance, Timing 
and Life Cycle Cost charts

	Ū Added optimization queues to observe which optimization 
is currently running

	Ū Allow optimizer to recalculate the structure weight for each 
year of the optimization period

	Ū Added Action User Cost as an associated benefit groups 
option for actions

	Ū NBI Element Conversions report that shows how the 
conversion profiles are interacting with the inspection data

	Ū Time in State report to identify how long bridges remain in 
their NBI Condition Ratings

In addition to the two releases in 2021, we have started the 
development of Version 6.6, which will include two new, 
highly anticipated modules supported directly by DOT 
involvement and funding contributions. More information 
about these new features can be found in the articles that 
begin on page 19. Version 6.6 is currently in development 
with a planned release in early 2022 with the following key 
features:

	Ū Funding by Project Category

	Ū Critical Findings/Request for Action Module

	Ū User Certification Module

	Ū STIP Project Import Tools

	Ū Various bug fixes and usability enhancements identified by 
the user community

Finally, the Task Force continues to monitor the proposed 
changes to the National Bridge Inspection Standards as 
well as the new Specifications for the National Bridge 
Inventory. A date has not been established for the official 
release of these proposed changes; however, the Task 
Force remains vigilant to ensure we are ready to respond 
without delay. Once the FHWA changes are complete, 
AASHTO will finalize and issue the solicitation request 
to fund AASHTOWare Bridge Management (BrM) 
revisions to support compliance with the NBIS and 
SNBI. The amount of the solicitation will depend on 
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the extent of the changes that will be required but is 
expected to be $300,000 per agency. To ease the impact 
to agency budgets, commitments paid over a two-year 
period will be an option. We ask that all agencies strongly 
consider supporting this important undertaking through 
participation in the upcoming project solicitation. More 
information on the project solicitation is provided on  
page 22.

If there is anything the Task Force can do to improve your 
experience with the AASHTOWare Bridge Management 
software, please feel free to contact us. The Task Force 
strives to provide the best bridge management software to 
meet the needs of all our users. 

Eric Christie, P.E. 
Vice-Chairman AASHTOWare Bridge Task Force

BrM supports the full life cycle of bridge 
management including bridge inventory 
management, inspection, life cycle planning, 
maintenance, capital program project selection 
and preliminary planning. 

	Ū National Bridge Inspection Standards (NBIS) and Coding 
Guide changes, now named the Specifications for the 
National Bridge Inventory (SNBI), which are expected to 
be finalized in late 2021.

	Ū Planning is underway for a BrM project to adopt and 
incorporate SNBI changes.

	Ū AASHTO to reach out to FHWA to request approval for 
members to use State Planning and Research (SP&R) 
funds at 100% federal participation (no agency match 
required).

	Ū Stay tuned! We need your support to secure sufficient 
funding to make this project successful.

BrM to Remain Federally Compliant—Solicitation Coming Soon
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Life Cycle Cost Analysis (LCCA)—Why Your Agency Life Cycle Cost Analysis (LCCA)—Why Your Agency 
Should Upgrade to BrM Version 6.5Should Upgrade to BrM Version 6.5
LCCA is a cost-centric approach used to select the most cost-effective alternative that accomplishes a preselected project 
at a specific level of benefits assumed to be equal among project alternatives being considered. While the initial version 
of the BrM LCCA module—delivered in 2016—provided a great start, this module was the first of its kind. Version 6.5 
provides a completely new and improved version of the LCCA module which is going to significantly help agencies 
do exactly what they are setting out to do, to complete life cycle cost analysis and maximize the health of their bridge 
networks.

This development of the revamped module went through an extended collaboration process, taking roughly 18 months 
to design, develop, test, and implement in total, with the help of direct state department of transportation involvement 
via Testing and Optimization TAG member participation. Special thanks to all who participated to make this release 
possible.

At the highest level, the new LCCA Optimization module will allow agencies to generate optimal Life Cycle Plans. 
The module analyzes different alternatives and recursively selects the alternatives with the least life cycle costs. In 
other words, the software examines all possible actions and combinations of actions to determine the right cadence of 
maintenance, repair, rehabilitation, and replacement to identify the lowest overall cost to maintain the bridge during a 
specified period.

So, why should your agency upgrade to version 6.5? The answer is simple… This release will help your agency meet its 
goals/objectives identified in your Transportation Asset Management Plans (TAMP). The LCCA module identifies 
projects to complete to meet your metrics/goals being targeting with locking in actions around your signature and critical 
bridges.

For additional information on the LCCA enhancement, please review the 6.5 release video here:  
https://www.youtube.com/watch?v=khFs-wVU4yY&t=3s

Questions can be forwarded to Mayvue at BrM@mayvue.com. Mayvue has plenty of resources available to discuss this 
release, life cycle cost analysis in general, or answer other questions that you may have.

Figure 1. LCCA Module Screens

https://www.youtube.com/watch?v=khFs-wVU4yY&t=3s 
mailto:Mayvue at BrM@mayvue.com
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Analytical ToolsAnalytical Tools
The AASHTOWare Bridge Management Task Force is in constant pursuit of providing the user community with 
effective and easy-to-use tools to perform their jobs effectively. Analytical tools are a recent addition to the BrM software 
that provides exactly that. Version 6.5 of the software added two additional reports: NBI Element Conversions Report 
and Time in State Report. These reports work in both Oracle and SQL Server. Additionally, Mayvue is working on a 
Project Importer tool that will be available in Version 6.6. The goal of these tools is to allow users to analyze their bridge 
networks and optimization results more easily.

	Ū NBI Element Conversions Report (available in 6.5): This 
shows how the conversion profiles are interacting with 
the inspection data.

	Ū Time in State Report (available in 6.5): This shows 
how long bridges have been in their rating condition, 
including when the bridge was assigned a condition 
rating along with the last date that it was in that 
condition. Available in 6.5.

	Ū Project Importer (coming in Version 6.6): This feature 
will allow users to download a Microsoft Excel 
template from the Project > Upload Project. From there, 
the user can populate the template with their project 
information and upload/import those projects into 
BrM. This will eliminate the manual data entry that 
previously existed for agencies.

Critical Findings/Request for Action (RFA) Module Critical Findings/Request for Action (RFA) Module 
Coming Soon to BrMComing Soon to BrM
In a joint development effort, the South Carolina Department of Transportation (SCDOT), Michigan Department of 
Transportation (MDOT), and Bridge Management Task Force designed and funded a critical findings/request for actions 
module that allows agencies to configure critical findings workflows at the agency level. It also allows for the creation, 
editing, and viewing of a critical finding within BrM, as well as the ability to see a complete list of critical findings for 
a given bridge and find pertinent information in BrM. A dashboard view for administrative users is also included. The 
design was reviewed and vetted through multiple iterations and various modifications to ensure it is flexible for use by all 
agencies. 

This module will be available to the user community 
beginning in Version 6.6. The module will include 
the following components, which create a great 
foundation for initial usage. We hope that agencies 
quickly adopt and enhance this module as needed.

	Ū Critical Findings Navigation and Bridge Summary Page

	Ū Critical Findings Configuration page

	Ū Critical Findings Bridge Level List

	Ū Critical Findings Page

	Ū Critical Findings Dashboard

	Ū Modified Work Candidates Page

	Ū Critical Findings Email Notifications

Figure 2. NBI Element Conversions Report

Figure 1. Critical Findings Dashboard
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User Certification ModuleUser Certification Module
Version 6.6 will also provide a module for managing user certifications within BrM, another high priority identified by 
BrM users. The design of and funding for this enhancement was a joint initiative of the South Carolina Department of 
Transportation (SCDOT), the Michigan Department of Transportation (MDOT), and the AASHTOWare Bridge Task 
Force. The module provides agencies with the ability to configure user certifications, experience requirements, and 
ultimately qualifications within BrM. The software contains logic to identify user qualifications for certain actions by 
using the certifications and experience information configured to support agency requirements. Additionally, users will 
be provided with a screen to manage and update their own work experience and certifications, including submission 
for approvals. The module provides a central location to review submitted user certifications for approval and allows 
administrators to monitor and manage current certifications and qualifications existing in the system. 

Overall, the addition of this module assists in the complete bridge inspection and management process, which is a goal of 
the Task Force.

The AASHTOWare Bridge Management Task Force is excited to continue its joint development effort with SCDOT and 
MDOT and bring additional enhancements and modules to the BrM community.

Figure 1. Display Samples from 
Certification Module
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Mobile Bridge Inspection Application Now Available!Mobile Bridge Inspection Application Now Available!

Bridge Inspection Software in the Palm of Your HandBridge Inspection Software in the Palm of Your Hand

In the July 2020, AASHTOWare bridge products newsletter, the Task Force advised that 
Mayvue was undertaking the development of a mobile bridge inspection application with 
the full support of the Task Force. The BrM Mobile Bridge Inspection powered by Mayvue 
application functions as an add-on to the AASHTOWare Bridge Management software and 
should be available to agencies through the AASHTOWare catalog in late Summer 2021.

Mayvue worked with several volunteer agencies to design this application with the goal of 
streamlining the inspection process, organizing the mobile application to what makes the 
most sense, and ensuring the most important features are available in the initial release. 
Some of the most desired features included in the mobile bridge inspection application are: 

	Ū Bi-directional sync—start in the field and finish at the office

	Ū Multimedia—capture and upload photos and sketches in the field directly from your phone or 	
	 tablet

	Ū Capture complex data—view and modify cross section, element, and clearance data

	Ū Configurable workflow—configure the data collection screens to what works for your agency

	Ū Feature parity—will remain in sync with BrM features

Please contact Mayvue (mobile@mayvue.com) for more information on this new offering. 

National Bridge Inspection Standards (NBIS) and National Bridge Inspection Standards (NBIS) and 
Coding Guide Changes/Specifications for the Coding Guide Changes/Specifications for the 
National Bridge Inventory (SNBI)National Bridge Inventory (SNBI)
As you are aware, the Moving Ahead for Progress in the 21st Century Act (MAP-21) required the U.S. Secretary of 
Transportation to update the National Bridge Inspection Standards (NBIS). Through a Notice of Proposed Rulemaking 
(NPRM), FHWA proposed updates to the NBIS to address MAP-21 requirements, incorporate technological 
advancements including the use of unmanned aerial systems, and address ambiguities identified since the last update to 
the regulation in 2009. Published in the Federal Register on November 12, 2019, the Federal Register docket accepted 
comments on the NPRM through March 13, 2020. The FHWA also proposed significant updates to the FHWA 
Recording and Coding Guide to conform to the NBIS updates and make other improvements. The updated Coding Guide 
is named the Specifications for the National Bridge Inventory (SNBI). FHWA also accepted comments on this document 
to the NBIS Federal Register docket through March 13, 2020.

The final draft of the NBIS and SNBI that addresses comments submitted in the Federal Register is under review by the 
new FHWA/USDOT administration then requires White House Office of Management and Budget (OMB) review and 
approval. Therefore, publication is not expected to occur in the immediate future.

mailto:mobile@mayvue.com
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Solicitation to Remain Federally CompliantSolicitation to Remain Federally Compliant

AASHTO’s licensing agencies have an enormous investment in their bridge and structure network and maintaining it in 
the most optimal and safe manner. At strategic times AASHTO, on behalf of the AASHTOWare Bridge Task Force issues 
project solicitations to fund significant improvement initiatives or to revise the core functionality of the BrM software to 
assist agencies in remaining federal compliant. Donations by member agency participants are pooled to achieve defined 
large-scale objectives through work plans with the contractor. The solicitation process is employed to fund significant 
mandated enhancements that are necessary to ensure the software remains relevant. 

The Task Force continues to monitor the proposed changes to the NBIS and SNBI. A date has not been established 
for the official release of these proposed changes; however, the Task Force remains vigilant to ensure we are ready to 
respond without delay. The development of the project work plan and project solicitation documentation—based on the 
requirements spelled out in the November 2019 NPRM—is in progress. The project work plan and solicitation will be 
aligned with the final NBIS/SNBI requirements once they are finalized and published.

Once complete, AASHTO will finalize and issue the solicitation request to fund AASHTOWare Bridge Management 
(BrM) revisions to support compliance with the NBIS and SNBI. The amount of the solicitation will depend on the extent 
of the changes that will be required, but is expected to be $300,000 per agency. To ease the impact to agency budgets, 
commitments paid over a two-year period will be an option. We ask that all agencies strongly consider supporting this 
important undertaking through participation in the upcoming project solicitation.

Opportunity to Commit Funding to the Project Solicitation  Opportunity to Commit Funding to the Project Solicitation  

Sooner Than LaterSooner Than Later

Based on feedback received from several AASHTO Member Agencies interested in participating in the upcoming project 
solicitation, we have learned that some agencies have “earmarked” funding in their current fiscal year budgets to commit 
funding towards the NBIS/SNBI BrM project. 

The solicitation commitment process cannot commence until the work plan is finalized and the work plan cannot be 
finalized until the requirements have been published. Therefore, for those agencies interested in committing funding to 
this important initiative prior to the publication of the NBIS/SNBI changes and issuance of the project solicitation, an 
alternate mechanism has been established to commit funding for the project.

Funding for the NBIS/SNBI BrM project can be committed to AASHTO via the FY2022 Member Software Request 
Form: Additional Enhancement Funding. All funding contributed in this manner will be reserved to support the project 
solicitation.

The Task Force has prioritized maintaining AASHTOWare Bridge Management’s compliance with national standards as 
its highest objective for the future. We will continue to monitor the timing of the release and continue to make you aware 
as we learn new information.
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ProductProduct AASHTOWare Bridge AASHTOWare Bridge 
Task ForceTask Force

WEBSITES
AASHTOWare® Bridge Management:
https://www.aashtowarebridge.com/bridge-
management/ 

AASHTOWare® Bridge Rating and Design:
https://www.aashtowarebridge.com/bridge-
rating-and-design/

SAVE THE DATES
2022 AASHTOWare Bridge  
User Group Meetings
Rating and Design Bridge User Group 
(RADBUG)

August 2–3, 2022—New Orleans, LA

RADBUG website: www.aashtobr.org

Bridge Management User Group (BrMUG)

September 13–14, 2022—Minneapolis, MN

BrMUG website: www.brmug.com 

For additional information on the bridge product 
user group meetings, please contact Ryan 
Fragapane, AASHTOWare Bridge Products 
Project Manager (rfragapane@aashto.org)

Todd Thompson—South Dakota DOT
Chair, Bridge Products Task Force

Eric Christie—Alabama DOT
Vice Chair/Task Force member, BrM

Beckie Curtis—Michigan DOT
Task Force member, BrM

Craig Nazareth—Rhode Island DOT
Task Force member, BrM

David Hedeen—Minnesota DOT
Task Force member, BrM

Kent Miller—Nebraska DOT
Task Force member, BrM

Derek Constable—FHWA
Task Force FHWA Liaison, BrM

Mark Bucci—Louisiana DOTD
Task Force member, BrDR

Michael Johnson—Idaho TD 
Task Force member, BrDR

Jeffrey Ruby—Kansas DOT 
Task Force member, BrDR

Vinacs Vinayagamoorthy—California DOT
Task Force member, BrDR

Tom Saad—FHWA
Task Force FHWA Liaison, BrDR

Ryan Fragapane—AASHTO
Project Manager

AASHTOWare Bridge AASHTOWare Bridge 
Product ContractorsProduct Contractors

AASHTOWare  Bridge Management
Mayvue Solutions, LLC
700 River Avenue, Suite 423
Pittsburgh, PA 15212
Contact: Josh Lang, CEO
Phone: 877-462-9883
Email: BrM@mayvue.com 

AASHTOWare Bridge Design and Rating
ProMiles Software Development Corporation
300 Corporate Center Drive, Suite 310
Moon Township, PA 15108
Contact: Herman Lee, Project Manager
Phone: 412-509-0587
Email: BrDR@promiles.com

https://www.aashtowarebridge.com/bridge-management/ 
https://www.aashtowarebridge.com/bridge-management/ 
https://www.aashtowarebridge.com/bridge-management/ 
https://www.aashtowarebridge.com/bridge-rating-and-design/
https://www.aashtowarebridge.com/bridge-rating-and-design/
https://www.aashtowarebridge.com/bridge-rating-and-design/
http://2020 AASHTOWare Bridge User Group Meetings
http://2020 AASHTOWare Bridge User Group Meetings
http://Rating and Design Bridge User Group (RADBUG)
http://Rating and Design Bridge User Group (RADBUG)
http://www.aashtobr.org
http://www.aashtobr.org
http://www.brmug.com
mailto:rfragapane%40aashto.org?subject=
http://www.aashtoware.org
mailto:BrM%40mayvue.com%20?subject=
mailto:BrDR%40promiles.com?subject=
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The AASHTOWare technical service program has 
a rich history of serving its customers and being a 
leader in bringing the power of technology through 
automation to the public sector transportation 
industry. 

As we look to the future, it is important that we 
build on this rich and robust tradition to create 
the next generation of technology solutions and 
continuously improve service to our customers. We 
base our success on the commitment of hundreds 
of volunteers, in partnership with the private 
community, to produce quality products that meet 
the common needs of our customers. The challenges 
we face now and into the future are increasingly 
more complex than in the past. To ensure continued 
success as we establish our next generation of 
products and services, we will clearly focus on a 
mutually agreed upon set of principles and values to 
drive our strategic plan, vision, mission, goals and 
objectives.

About AASHTOWare®

American Association of State Highway  
and Transportation Officials

555 12th St. NW, Suite 1000, Washington, DC 20004
www.aashtoware.org | rfragapane@aashto.org | 202-624-3632

http://www.aashtoware.org
http://www.transportation.org
http://www.aashtoware.org
mailto:jtarwater%40aashto.org?subject=

